
 

 
 

  

Legal Information Institute 
1995-96 editions 

Installing, Exploring, and Personalizing LII 
Course Materials 

(Full Documentation is Contained in the VIP Help File) 

I. Installing the VIP Software and LII Course Materials 
 
A. Windows Users 
 
Insert the CD into your CD-ROM drive.  Within Windows choose Run from 
the Program Manager File menu.  Enter d:\setup.  (If your CD-ROM drive 
is not your “d” drive but uses another letter substitute that letter.) Follow 
the instructions that appear on the screen. 
 
B. DOS Users 
 
Create a directory for the DOSVIP software on your hard drive (e.g., 
c:\dosvip).  Insert the CD into your CD-ROM drive and copy all files from 
its \dosvip directory to the one you have just created.  You can leave the 
rest of the material on the CD although performance will be improved if 
you copy all the files whose names end in “.nfo” to your hard drive as well 
(in the same directory as dosvip).  (Copy d:\*.nfo c:\dosvip) .  (If your CD-
ROM drive is not your “d” drive but uses another letter or you named the 
new directory on your hard drive something other than \dosvip make the 
appropriate substitutions.) 
 

II. Terms of This License 
 
The educational materials published on this disk incorporate the FOLIO VIP 
Software ("Software") licensed from the FOLIO Corporation.  While the 
educational material may include public domain documents, all editorial 
additions and comments and links added by the LII are copyrighted.  The 
Software is as well.  With the receipt of this disk, the user receives a non-
exclusive limited license to use both in his or her study, teaching and legal 
research.  The license to use both is limited to use by a single user on a 
single computer at one time.  (Unless the parties have specifically agreed 
otherwise this is not a network license.) The license to use the Software is 
limited to the educational material furnished with this disk.  The user is 
specifically not authorized to make copies for others.  Additional copies are 
available from the Legal Information Institute, Cornell Law School, Myron 
Taylor Hall, Ithaca, NY 14853.  A more detailed statement of the terms of 
this license is set forth at the end of this document. 
 



 

 
 

  

III. Opening an Infobase File 
 
A. Windows Users 
 
From the program groups on your Windows desktop choose the group 
called Core Materials on Legal Ethics and, from it, the menu most suitable 
for your work.  (All menus provide access to the same material. They differ 
only in how the choices are arrayed.  If you wish to eliminate menus you 
aren’t likely to use, you can delete them using the Windows Program 
Manager.)  A double-click on the menu icon will open the VIP software 
and an infobase that links to all others in the collection.  (While the menus 
furnish access to all infobases on the disk, you can open any infobase 
directly by following the instructions on opening a file for DOS users set 
forth below.) 
 
B. DOS Users 
 
Once you have installed the VIP software, you begin by typing dosvip at the 
DOS prompt for the directory to which you have copied it.  Within VIP, 
select the File pull-down menu on the “Main Menu Bar” and Open the 
"infobase" menu file corresponding to your interest.  (If the software and 
the infobases have been copied into the same directory you will not have to 
change directories to do so.)  For those generally interested in Legal Ethics 
this will be genmenu.nfo, for those focusing on California, D.C., Idaho, or 
Texas, it will be calmenu.nfo, dcmenu.nfo, etc.  Choose an item from the 
menu by double-clicking. 

IV.  Working with an Infobase 
 
A. Choosing Your Point of Entry from the Table of Contents and 
Exploring What You’ve Found 
 
Table of Contents 
 
Once you have opened one of the infobase files, choose the table of contents 
icon ("Contents") from the Toolbelt strip on the left side of the screen 
(Windows) or "Table of Contents" from the "View" pull-down menu (or 
simply Ctrl-T).  The full structure of the code or statute published in LII 
format can be expanded and closed, allowing you to open parts to see their 
constituent chapters, to open chapters to see subchapters and so on.   
[Final Note for DOS Users:  The DOS version of the software does not have 
a Toolbelt strip.  All functions noted in the following sections as being 
available (in Windows) via that strip are also available from the Main 
Menu Bar across the top of the screen in both Windows and DOS versions. 
Many of those features (like Table of Contents) can also can be summoned 
by a function key or keystroke combination.  Therefore, in reading this 
documentation DOS users should ignore references to the Toolbelt and 
focus on how each command or function can be accessed from the Main 
Menu or keyboard.] 
 
Clicking on the + or - to the left of a table entry expands or contracts it.  A 
double-click on the heading of a section (or a larger unit) will open the full 
document at that point. 
 
You will want to experiment moving around in the dynamic table of 
contents, using it to enter the statute or code at different points.  Observe 
how much more useful it is, both as a vantage point on the whole and as a 
means of gaining access to an appropriate starting point, than a print 
analog would be. 
 
Moving 
 
You may move the insertion point (cursor) with the mouse anywhere on 
the current screen simply by moving the mouse cursor to that position and 
clicking once. 
 
You may move up and down through the infobase with the mouse by using 
the Vertical Scrollbar.  To move a short distance up or down, click on the 
Up or Down arrows (located at the top and bottom of the scroll bar).  To 
move a long distance through the infobase use the Slider on the scrollbar.  
Click on the slider and drag it up or down the scrollbar. 
 



 

 
 

  

B.  Following Cross-References and Other Links 
 
Cross-References 
 
Legal statutes and codes are filled with cross-references (as annotations, 
decisions and legal memorandums are with citations). Open a section or 
rule and browse through it and its successors until you find a reference to 
one or more other sections.  (Rule 2-200 of the California Rules of 
Professional Conduct, for example, contains references to Rules 4-200 and 
2-300.)  Notice that the cursor changes its shape as it crosses such a 
reference.  (With a color monitor, all linked cross references appear against 
a gray background.)  Double click on the reference to follow the link.  
Immediately you will be looking at the cited section or sections.  To retrace 
that hypertext jump, you need only click on the "Backtrack" icon on the 
Toolbelt (or select Backtrack from Search on the Main Menu Bar or F-5).  If 
you have followed several links you may wish to click on "Show Trail" 
instead and go back several steps at once (also accessible via the Search 
pulldown menu).  In cases where one section contains a reference to a 
range of other sections (e.g., section 106 of the Copyright Act refers to 
sections 107 through 120), the first double-click will present a list of 
section headings.  Doing a second double-click on any of them will open 
up the section in question.  Backtrack will return you to the list. 
 
Defined Terms 
 
Many statutes and codes contain definitions of key words and phrases.  
Anytime you encounter such a term in an LII publication you can refer to 
the definition with a double-click (and return via Backtrack).  With a color 
monitor, all defined terms appear in blue and the link to the definition is 
also signaled by the change in cursor shape. 
 
Other Links 
 
Other links -- whether to commentary, editorial notes, or to the collection 
of comparable provisions from other jurisdictions -- are clearly marked in 
the text and shown in red or yellow. 
 
C.  Doing a Full Text Search of the Document(s) 
 
One can do a search of a statute, code or set of rules published by the LII 
with all the sophisticated possibilities offered by the on-line systems and 
more.  Once you have added annotation to an infobase (see below), your 
notes and highlighting also become searchable. 
 
Entering a Query: 

 
1.   From the main menu choose Search and Query.  The Query 

Dialog will appear. 
The Word List contains every word which has been indexed in 

the infobase.  The Results Map shows you how many records in 
the infobase contain the word(s) you are looking for. 

 
2.   Enter a query by typing words into the Query Box.  VIP will 

guess what word you are typing and fill in the rest of the letters 
for you.  If VIP has guessed wrong, just keep trying.  If VIP has 
guessed right, press ENTER once to accept the word as part of 
your query. 

 
3.   Press ENTER to see the results of your query (your search "hits") 

in the infobase. 
 

Query Syntax: 
 
Multiple words to be searched for may be separated by a space or an 
ampersand (&) or the word "and".  All three have the same meaning, i.e., 
VIP will look for all the connected words within the same record.  "Or", 
"not" and proximity operators can also be used.  A phrase may be searched 
for by enclosing the phrase in quotes. 
 
The Question Mark (?) is the Single Character Wildcard.  The Single 
Character Wildcard is used to replace a single character in a word.  For 
example, the query "t?p" would find words such as "tip" and "top". 
 
The Asterisk (*) is the Multiple Character Wildcard.  The Multiple 
Character Wildcard is used to replace 0 or more characters in a word.  For 
example, the query "perform*" will find words such as  "perform," 
"performer," and "performance." 
 
See the VIP Quick Reference Sheets for a full summary of query syntax. 
 
Search Results and Table of Contents 
 
The Table of Contents Window can be used to help you analyze search 
results.  Once you have performed a search, you may wish to choose View 
and inspect the query results in the Table of Contents.  Next to each 
heading will be the number of records with hits in that section of the 
infobase.  By selecting View and Headings With Hits or Words Around 
Hits (or both) you can bear down on the location and context of your hits. 
 
D.  Marking Up an LII Publication 
 
The VIP software allows the user to place bookmarks, to place electronic 
notes in the margins, and to apply numerous highlighters, each with a 
different meaning.  (You must have logged in as "Licensee", see below, in 
order to apply these tools directly to a course materials infobase.)  The 
“Personal Notes” file accessible off all the menus has been specifically 
designed to receive such annotations and doesn’t require a special login.   
 



 

 
 

  

Shadow Files 
 
In addition, by creating a “shadow file” for any of the infobases you can 
put annotations in a separate file. They will function as though they were 
part of the original infobase so long as you have opened that shadow file 
and are viewing the infobase through it.  To create a shadow file, first open 
the infobase to which it will relate.  Select File and then New from the Main 
Menu.  Give your new shadow file an appropriate name, putting it in a 
directory on your hard drive or on diskette.  Once a shadow file has been 
created it can be open directly just like an infobase, without opening the 
original infobase first.  (And if you open the infobase directly or via one of 
the menus you will not see any of the material contained its shadow file(s).) 
 Shadow files carry the suffix ".sdw". 
 
Highlighters 
 
Infobases come with four predefined highlighters named for their 
corresponding colors.  You may change these names to ones more suitable 
to your needs and create additional highlighters. 
 
Changing the Name of a Highlighter: 

 
1.   To change the name of a highlighter, choose Customize and 

Highlighters from the main menu. The Highlighter dialog will 
appear. 

2.   Select the name of the highlighter you wish to rename and 
choose Rename. 

3.   Enter the new name of the highlighter and choose OK. 
 
Creating a New Highlighter: 

 
1.   From the main menu choose Customize and Highlighters.  The 

Highlighter dialog will appear. 
2.   Select Highlighter Name and enter the name of the highlighter 

you wish to create. 
3.   Choose Add.  The highlighter will be added to the Highlighter 

Name list. 
4.   Choose Character.  When the Character dialog appears, add the 

attributes and colors you would like to associate with this 
highlighter.  When finished, choose OK. 

 
Applying Highlighters: 

 
1.   Select text.  Move the insertion point to where you want to start 

selecting text.  Click and hold the mouse button and drag the 
cursor to the end of the text to be selected.  Release the mouse 
button.  All selected text will appear in reverse video. 

2.   Choose Customize and Highlighter from the main menu.  The 
Highlighter dialog will appear. 

3.   From the Highlighter Name list, choose the name of the 
highlighter you wish to apply.  Choose Apply.  The text to which 
the highlighter was applied will change color. 

 
Bookmarks 
 
Bookmarks help you keep your place within the infobase and can be used 
to mark numerous points of temporary or long-term interest.  VIP allows 
an unlimited number of bookmarks, each with a distinct descriptive name. 
You may return to any one of your bookmarks from anywhere in the 
infobase. 
 
To Create a Bookmark: 

 
1.   Position the insertion point (cursor) where you wish to add a 

bookmark. 
2.   From the main menu choose Customize and Bookmark. 
3.   Enter the name of the bookmark you wish to add and choose 

OK. 
 
To Jump to a Bookmark: 

 
1.   From the main menu choose Customize and Bookmark. 
2.   Double click on the name of the bookmark you wish to jump to 

or select the name and choose OK.  You will jump to that 
bookmark. 

 
E.  Linking to an LII Publication 
 
While the VIP software that comes with this publication does not allow you 
to create new infobases, you can create your own links within this one, 
including links from your marginal notes and the Personal Notes file. In 
addition, with a licensed copy of the full Folio Views 3.x a user can link 
notes in another infobase to this one.  In either case constructing such links 
to the right point in an LII publication is as easy as citing that point.  All 
statutes and codes published by the LII have each unit named according to 
a scheme derived from its standard print citation.  As a consequence, the 
appropriate jump destination can readily be pulled from the list shown at 
the time a jump link is being established.  (To create a link to New York’s 
Disciplinary Rule 2-103, for example, you would need simply to have that 
infobase open, select it as the destination of a “Jump Link” and choose 2-
103 as the Jump Destination for the link.) 
 
F.  Other Details of LII Format 
 
All section headings are linked to the statute or code at precisely that point. 
This means that if the section the user wants to inspect appears at the 
bottom of the screen, clicking on its heading will bring it to the top.  This 



 

 
 

  

approach also allows queries and query links to generate lists of sections 
that can be opened by a double-click. 
 
All section numbers are held in a numerical fields so that searches and 
query links using them can pull in ranges of sections by means of the 
>=and <=symbols. 
 
Different levels of hierarchy within the statute or code are presented by 
different paragraph styles.  These cannot be adjusted with the VIP software, 
but users with full featured VIEWS 3.x can modify these styles to 
personalize the presentation of sections, subsections, and so on. 
 
G.  Security and Shadow Files 
 
The course materials are set up to be "read only" unless the user opens a 
shadow file or logs in as "Licensee". If you login as "Licensee" and furnish 
the password "liicensee95" you can add notes, bookmarks, highlighters and 
links directly to the infobase file (rather than in a separate shadow file).  
Once logged in as "Licensee" you can change the associated password to 
one of your own devising.  Bear in mind that to change any of the infobases 
in any way you will have to install them on your hard drive. On the CD-
ROM they cannot be annotated, except via a shadow file that you have 
created on your hard drive or diskette. 
 
Shadow files allow users to personalize an infobase by adding their own  
notes, applying highlighting, and creating links - without actually 
changing the master copy of the infobase.  Each user may have one or more 
shadow files, thus users may share one infobase without affecting one 
another's work. 
 
H.  Printing 
 
You can print an entire infobase, all selected or tagged text in the infobase, 
or a range of records from the infobase.  You may specify the margins for 
the printed page as well as a header and footer for the printed text. 
 
Printing the Entire Infobase: 

 
1.   From the main menu choose File and Print.  The Print dialog will 

appear. 
2.   Under Print Range choose View. 
3.   Press ENTER or choose OK.  The entire infobase will print. 

 

Printing Tagged Records: 
 
1.   Tag the records you wish to print (press F6 when in the  record 

you want tagged). 
2.   From the main menu choose File and Print.  The Print dialog will 

appear. 
3.   Under Print Range choose Tag. 
4.   Press ENTER or choose OK.  The tagged records in the infobase 

will print. 
 
Printing a Range of Records: 

 
1.   Find the numbers of the records which you wish to print.  

Record numbers are displayed on the Status Line. 
2.   From the main menu choose File and Print.  The Print dialog will 

appear. 
3.  Under Print Range select Records.  Enter the starting record in 

the From field and the ending record in the To field. 
4.   Press ENTER or choose OK.  The selected text will print. 

 
I.  Saving 
 
To save any changes you have made to a file choose File and Save from the 
main menu. 
 
J.  Exiting 
 
VIP may be exited by choosing Exit from the File menu or by pressing 
ALT+F4.  All open infobases will be closed as well.  If changes have been 
made to any open infobases, you will be prompted to save them. 



 

 
 

  

V. Ordering Additional Copies or Other LII Titles 
 
This CD-ROM and all other LII publications for 1995-96 are licensed 
together with the FOLIO VIP software necessary to run them.  They are 
offered on an individual title basis for $20 per copy.  The LII will license its 
full list of publications to a law school or similar institution at a rate of 
$500 for the academic year for installation in a local area network or 
multiple public workstations in the school's library or student lab.  (Similar 
network/institutional licenses are available for individual titles at the rate 
of $1 per student enrolled in the relevant course, with a minimum fee of 
$30.)  The LII also offers a special bulk rate to institutions prepared to 
handle the distribution of individual copies to their own students. 
 
To order additional copies or titles or for further information you can 
contact the LII by mail, e-mail, fax, or phone: 
 
 MAIL: Ms. Linda Majeroni   
  Legal Information Institute 
  Cornell Law School 
  Myron Taylor Hall 
  Ithaca, NY 14853 
 PHONE: 607-255-6536 
 FAX: 607-255-7193 
 E-MAIL: majeroni@law.mail.cornell.edu 

VI. Detailed Statement of VIP License Terms 
 
The purchaser or other recipient may not and may not permit others to (a) 
disassemble, decompile or otherwise derive source code from the 
educational materials or the accompanying FOLIO VIP Software 
("Software"), (b) reverse engineer the Software, (c) modify or prepare 
derivative works of the Software, (d) copy the Software, except to make a 
single copy for archival purposes only, (e) rent or lease the Software, (f) use 
the Software in any manner that infringes the intellectual property or other 
rights of another party, or (g) transfer the Software or any copy thereof to 
another party, unless the purchaser or recipient transfers all media and 
written materials in this package and retains no copies of the Software 
(including prior versions) for his own use. 
 

Limited Warranty and Limitations of Liability 
 
For a period of 60 days from the date the Software is acquired, the Legal 
Information Institute warrants that the media upon which the Software was 
transferred will be free of defects that prevent the purchaser from loading 
the Software.  The Institutes sole obligation under this warranty is to 
replace any defective media, provided the purchaser has given notice of the 
defect within such 60 day period.  The FOLIO VIP Software is licensed on 
an "AS IS" basis without any warranty of any nature.  FOLIO AND THE 
LEGAL INFORMATION INSTITUTE DISCLAIM ALL OTHER WARRANTIES, 
EXPRESS OR IMPLIED, INCLUDING THE IMPLIED WARRANTIES OR 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.  FOLIO 
AND THE LEGAL INFORMATION INSTITUTE SHALL NOT BE LIABLE FOR 
ANY DAMAGE OR LOSS OF ANY KIND ARISING OUT OF OR RESULTING 
FROM YOUR POSSESSION OR USE OF THE SOFTWARE (INCLUDING DATA 
LOSS OR CORRUPTION), REGARDLESS OF WHETHER SUCH LIABILITY IS 
BASED IN TORT, CONTRACT OR OTHERWISE.  IF THE FOREGOING 
LIMITATION IS HELD TO BE UNENFORCEABLE, FOLIO'S AND THE LEGAL 
INFORMATION INSTITUTE'S MAXIMUM COMBINED LIABILITY TO YOU 
SHALL NOT EXCEED THE AMOUNT OF THE LICENSE FEES PAID BY YOU 
FOR THE SOFTWARE.  THE REMEDIES AVAILABLE TO YOU AGAINST 
FOLIO AND LEGAL INFORMATION INSTITUTE UNDER THIS AGREEMENT 
ARE EXCLUSIVE.  SOME STATES DO NOT ALLOW THE LIMITATION OR 
EXCLUSION OF IMPLIED WARRANTIES OR LIABILITY FOR INCIDENTAL 
OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS OR 
EXCLUSIONS MAY NOT APPLY TO YOU. 



 

 
 

Folio VIP 
Version 3.0 Quick Reference Sheets 

 
These reference sheets are designed to help you get started as quickly as 
possible with the VIEWS Infobase Personalizer (VIP). VIP is a read-only 
product which allows you to browse, search, annotate, print, and export 
information in infobase format. Should you need additional help with VIP, 
please contact the publisher of the infobase. 
 

The VIP Screen 
 

 
 
A - System Menu – Allows you to move, size, and close VIP from the 

keyboard. 
B B - Main Menu – Provides primary access to all of VIP features. 

C C - Reference Window – Shows you where you are in the infobase. 

D D - Toolbelt – Provides one-click access to common functions (user-
modifiable). 

E E - Document Window – Displays the text of the infobase. 

F F - Vertical Scroll Bar – Lets you move up and down in the infobase with 
the mouse. 

 G G - Status Line – Displays important information, including the number of 
query hits. 

VIP Query Syntax Summary 
 
Press F2 to open the Query dialog. For more details on Query, press F1 
when in the Query dialog.



 

 
 

  

VIP Quick Keys 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Select:  Shift+Direction Key (arrows, PAGE UP, PAGE DOWN, etc.) 
Note: Editing Quick Keys (such as Bold & Italics) are only available in Notes 
and Popups. 
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